agre * TRONIA

SYSTEMS

WORK ORDER TO PURCHASE ORDER PROCESS

The Work Order to Purchase Order Process is designed for copying the details of a customer
work order to a corresponding purchase order without having to enter the same information
twice.

Straight products, associated products, and non-inventory products can be copied.
Blends cannot be copied.

The Work Order to Purchase Order Process is not compatible with the Work Order Approval

Process.
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Security Permissions Required

*The minimum permission required to use the WO->PO process is the ability to create a purchase
order.

Not all users require permission to do all WO->PO tasks, but at least one user should be allowed

to do everything.

Accounts Receivable
e Work Orders — Add Orders, Edit Orders

* Edit Role: LordOfTheUniverse [ [0 [
E Save | X Delete @ Exit

Role  Pemissions l

Accounts Receivable | In\rentory] Accounts Payable ] General Ledger] Blending ] Grain ] Agmnomﬂ Administration ]

ltem Action Mlow? Deny? ~ Allow All

‘whork Orders —. Add Orders |
- )
2dd Quotes ml Deny All
— |Edit Orders ] Clear Al |
Total Permissions: 207 Allow: 207 Deny: 0

File > Security > Manage Roles

e Work Order Sub Types — Enable on Menu, Manage

Accounts Receivable | In\terltory] Accounts Payable ] General Ledger] Blending ] Grain ] ﬂtgronomy] Administration ]

ltem Action Allow? Deny? ~
‘wiork Order Sub Types = |Enabls on menu [l
—h Manage [l v

Inventory

e Products — Edit

Accounts Recsivable  Inventory I.P«:c:ounts Payable | General Ledger | Blending ] Grain ] ﬁgronom:.r] Administration ]

ltem Action Allow? Deny? -
> |Products Add ]
— | Edit [
o Delete ]
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Accounts Payable
* Purchase Orders — Add, Edit, Delete

Accourts Receivable | Inventory  Accourts Payable ]Geneml Ledger | Blending | Grain | Agronomy | Administration |

Item Action Allow? Deny? ~
Purchase Orders —h Add [l
 |copy [
—P» |Edit [
:k Delete [

Enable on menu ] -

e PO Sub Types — Enable on Menu, Manage

Accounts Receivable ] Inventory  Accounts Payable |Geneml Ledgerl Blending l Grain l Agronon'ry] Administration ]

ltem Action Allow? Deny? ~
PO Sub Types —k Enable on menu (&
—k Manage [l v

e Suppliers — Edit

Accounts Receivable ] Invertory  Accourts Payable ]Genelal Ledger] Blending ] Grain ] ﬂtgronomy] Administration ]

ltem Action Allow? Deny? ~
Suppliers Add ]
—P |Edit ]

| Delete [l o

Setup Tasks

Setup tasks need done only once.

Once Tronia has enabled the WO->PO Process, you'll see additional Company Config Options on
the Accounts Payable / Purchase Order tab and the Accounts Receivable / Work Order tab.
Choose the options that best fit the way your company will use the process.
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Accounts Payable Company Config Options &’

Purchase Orders

% Company Level Settings \El@
u Save @ Exit
General l Accounts Receivable ] Elending =~ Accounts Payable lGBI‘IEIﬁ| Ledger Inverrtoryl Agronomy] Grain ] Reports l Messages l

Purchase Invoices  Purchase Orders ] Suppliers ] Payments ]

w0 to PO Process
[Tochangs these settings, pleass
I contact Tronia Systems)

v Use WO Reference for PO
(¥ ‘with PO Prefix

(" ‘With Custom Prefix

[ Use WO Pricing for PO

File > Config Option > Company

e WO to PO Process: Enable Process Tronia will turn this on

e Use WO Reference for PO the default purchase order reference number will either:
e follow usual location PO standards
(same as if the PO was added manually and not created from a work order)

[ Use WD Reference for PO
{+

» [
e use the usual PO location prefix and set the numerical portion to match the work order
reference number

I+ Use WD Reference for PO
v ‘with PO Prefix

{ with Custom Prefix

e use a custom PO prefix (5 char max) while still maintaining the numerical portion of
the work order reference number

v Use w0 Reference for PO
" With PO Prefix

% \ifith Custom Prefix [WOPO .

e Use WO Pricing for PO: check to copy work order prices to the purchase order (S0 margin)
(paying less to the supplier than what you charge the customer is one way retailers increase
profit, but that may not be your business model for this process)
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Accounts Receivable Company Config Options %’

Work Orders — General Defaults

% Company Level Settings
n Save ﬂ Exit

General Accounts Receivable ] Blending l Accounts Payable l General Ledge:

Invoices ] Loadout Tickets Work Orders ] AR Releasze Mo l AR Payments |

General Defautts ] Linking//Imparting ] Expiry Date ] Service Dates ] Pay:

I Ul Ao Crvoronreadicel

Wi to PO Process
¥ Supplier is Mandatory
™ Limit Products based on Supplier
Matify all users in specified role when:
Linked WO Edited ~|

File > Config Options > Company

e Supplier is Mandatory (optional) if checked:
e applies to ALL work orders (regardless if creating a purchase order from it or not)

e but keep in mind only work orders with a Supplier can be turned into a purchase order

e Limit Products based on Supplier (optional) if checked:
e applies to ALL work orders (regardless if creating a purchase order from it or not)
e remember to link Suppliers to products (see Product Setup below)

e supplier must be selected before products can be added to work orders, and only
products linked to the selected supplier can be added

e quotes cannot be turned into orders
(the Order button becomes inactive as soon as products are added)

e Notify all users in specified role when: Linked WO Edited (optional) select a security role to
receive messages when a WO linked to PO is edited.

On the Messages tab you
can setup more notifications
Tip  Take advantage of the other work order and purchase for WOs and POs!

order config options to customize the process to match
your workflow, from requiring customer shipping
addresses to making pricing mandatory.
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Grower Central Config Options %’

Products

 Grower Central Options [E=8 ESH 55 |

& Save l |_] Start Over | € Ext

General I Reports l Documents ] Agronomyl Grain l Online Fayments] Quotes/Orders | Products

- Include Product Types: | | Product Type Int;lg_de? | A
» | Chemicals | @
. . _ Dry Fertilizer @
]
]
: Fuel - Wholesale ]
L | —
Show Supplier Grain B
V¥ Limit Products based on Supplier (WO > PO) e |
j'r!qtemal [
e SR N eAsediinen R

File > Config Option > Crower Central

e Show Supplier: (optional) check to display the supplier on the Products page

1152

Dry Fertilizer
11-52-0
IRM Ltd. $500.00/ MT

Add to Order View

e Limit Products based on Supplier (WO->P0O): (optional) check to limit online orders to
products from a single supplier

Order Error

You have selected products from more than one supplier.
Please ensure that each order request contains products
associated to a single supplier.

You will not be able to submit your online order until this has

been corrected.
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Direct Supplier Setup

e Only Suppliers flagged as a Direct Order Supplier (WO)? can be selected as the supplier on
a work order

e If Supplier is Mandatory (company config option) is checked, at least 1 supplier must be
flagged as a Direct Order Supplier

4ih Edit Supplier: IRM (0058) =N F=R
[E save Refresh | €3 Bt

Supplier lContacts ] Addresses ] Settings ] Notes ] Comments

Supplier Code: 0058 * v
Supplier Name: |IHM - v Sensitive
Susnlier Mias: | Primary Phon=;

| Mapping Code: |— h

I Trucking/Delivery Company?
Add Characteristic . )
h ¥ Direct Order Supplier (W0)?

Accounts Payable > Manage > Suppliers

Product Setup

e [f Limit Products based on Supplier (company config option) is checked, at least 1 product
needs to be linked to a direct order supplier on the product’s Inventory tab

e Products can be linked to one or multiple suppliers

+ Edit Product: WOLFBORON - Wolftrax 18.5% DDP Boron =N =N |
[ Save Refresh | #< Delete hii Prices/Taxes | €3 Ext

Product l Units ~ Inventary l MNotes l Associated Products ] Blending ] Manufacturing | Dangerous Goods ] Regulations l Grown

Supplier Product Code Mappings: Product Programs:

Supplier Supplier Product Code Programs

Soil Suravor (1058) WT-B185 =" A
> | Parkland Ag Supply (1044) 34529

Add Code Row | Edit Code Row Remove Code Add

Inventory > Manage > Products

Work Order To Purchase Order Process Page 7 of 17



Associated Product Setup

e [f Limit Products based on Supplier is checked, any associated products added to the work
order will also need to have the same supplier setup; a warning will be displayed after adding
a supplier

[&1 [
Azsociated Products Found >

Ensure that any associated products are also linked to the
r l"w_ same supplier(s).

LT

.

Common Work Order/Purchase Order Sub Types

e For the Sub Type to copy over from WO to PO, it must exist for both Work Orders and
Purchase Orders

*» Manage Work Order Sub Types = ol =
[ save | € Edt
» Manage PO Sub Types =N =N
Description n Fox ,‘3 Exit

= iContract —

i -\\- Description Active A

Max Price Contract L ontract

Rateable Prepaid
Rateable Regular

IEEE

Accounts Receivable > Manage > WO Sub Types
Accounts Payable > Manage > PO Sub Types
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Creating the Work Orders

Work Order Home Form

Work Orders can be created from the Customer Account or the Work Orders home form, but
turning one into a Purchase Order can be done only from the Work Orders window.

Work Orders already linked to a Purchase Order display the Purchase Order Reference Number
and cannot be linked again (but you can delete the linked PO and start the process over).

"

&

Customer 2

Carter, Alexander

Carter, Alexander 022

Jun 30, 2023 | Order

I WorkOrders ] e
J =+ Add |fEdit | XDeléigr | =+ Creste Purchase Order ‘%F‘r&\n’ew tem - lkjcry |6E:rt ‘
3Y I 25

Status ¢ ‘work Order Number PO Reference
D359

Martin, Lyle

Jun 30, 2023 | Order Active /D)

BEw0137

WOP0137

/
34
3 'Wwork Orders found %%

Work Order Search

Accounts Receivable > Work Orders

The Imported PO? search criteria can filter for work orders linked to a purchase order, or for

those that are not.

J Work Order Search

JbSearch |D51E|rt0ver ‘Q&n ‘

Reference Number: I

Status: |<Am' Status> LI
Authorized: |Ether =]
Location: |<.NI Locations> ;l

Customer Order No: I

[ Show WO with no Release Numbers

Linked PO: |

Imported PO7?

Sales Rep: I

Work Order To Purchase Order Process
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Adding Work Orders

When adding a work order, the fields highlighted in yellow will be copied to the purchase order.

Copying prices is configurable.

Work Order Header & Customer and Order Tab

St. Albert, AB T8N 4R7

Manage Customer
j Find Add

Ship To

Campbell Park Road

335 Campbell Park Road
St Albert, AB TN 7L1

| Edit Work Order: DWO363 =N SR

[E Save | # Delete |} Documerts Refresh | EE1 WO Activity Detail History >§1 View Credit '@ Exit

Reference: DWO363 - Type: " Quote ™ Order SubType: |Contract -

Customer: |Campbe|| Park Fertilizer (1054) ﬂ T =2 Add Location: |Dog River ﬂ -

Date Ordered: Nov 18, 2022 ~|"  Status: Active - Created By: |agre User

Expiry Date: Jun 30, 2023 - Comments: |Direct Shipment
Customer and Order | Products (1) ]

Billing Address Service Details
Phone #:
34 Sturgeon Road Service Dates: Dec 19, 2022 ~ | to | Dec 31, 2022 -

[ No Service Dates

Authorization

Authorized By:

Authorized Date: ~| ¥ No Authorization

Payment Terms

. Payment Due: hd [+ Mo Due Date
Sales Rep: oL = PaidIn Full? |~ Deposit:
Customer Order No: |23255'
Terms: j
Customer Contact: |Dale Evans J I~ Custom
Supplier: [IRM (D058) ~|" Find
Accounts Receivable > Work Orders > Add
e Sub Type to be copied, it must exist for both WO and PO
e Supplier may be mandatory (configurable), is limited to Direct Order Suppliers only
(becomes the supplier on the PO)
«1h Edit Supplier: IRM (0058) =N E=

E Save Befresh @ Exit

Supplier ]Contacts ] Mddresses ] Settings ] Motes ] Comments ]

Supplier Code: ’[}{)537 - 4
Supplier Name: |IRI'U1 - ¥ Sensitive
— e gt ST G :_ =2 =
Mapping Code: |

Add Characteristic |

[ Trucking/Delivery Company?
_.' Iv Direct Order Supplier (W0)?

Accounts Payable > Manage > Suppliers

Work Order To Purchase Order Process
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Work Order Products Tab

:Bé.w X Detete ||| Documerss | [ Refresn  TIWO Actvay Detad [T Hitory | 85 View Crect | @9 B2
T T — Type " Quate & Order  SubType: [Contract -l
Customer: oot Park Fenioer (1054) )" Fmd | a4 | lecson  [GozFer Bl
OateOrderng  [Nov 18,202  »°  Staus - Crawnd By [agre Lser
ExpryDete  |An30.208  (+” Contrants |Drect Shpment
~— oplionsl
cm---u (corfg option)
Product Quantity  UnaPrical  Lisa Totol Coowimed|  Taken Umdlocstion  |Sos  [Relese.  Prepsy? |
600 - 4200 (MT) 20 oW sNe0w @ | 00! 200cofiver |2ctive | T Il
~ nmensivm 420 ssom  saoom| | 00/ 420 CegRww |Actve | | £l
> | 0-0-68 - 0060 (MT) Q0  soa00 sa7ei00| @ | 00 420 DogRiver  |Active | T £ |
A Froduct | AddNemized Binds | Add Bt | Tetal: {befiore tax) 3248500
EmRow | FRemovefow | lecce Aguaary | Aelease e | Tomal. with tanae) 38248200
Accounts Receivable > Work Orders
Add Work Order Product Row ®

JOUpdate |F{efr&sh |£3|5m |

~1" Find |

can be copied to PO

Quantity Limit at this Price:

Product:  [46-0-0- 4600

Units: IMT— Metric Tonne LI-

Location: IDog River

Unit Price: £500.00

Quantity on Hand: I 9630335 Details |
Quantity Requested: 20 "

(company config)

Prepay?  Pricing |

™ Use Current Price on Invoice?

W Committed? [ Mo Quantity

420

Line Comments:

L e e

| not copied to PO I

Shnda'dl

i T agiae

Accounts Receivable > Work Orders

Supplier is selected

Cannot Add Row

i You must select a supplier first.

Work Order To Purchase Order Process

if Limit Products based on Supplier (config) is checked, products cannot be added until a
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e if Limit Products based on Supplier (config) is checked, Products added are limited to only
those linked to the selected supplier through
Manage Products

® Find Product

i Find b Use Selection | Previous Search | 7222 Price & GoH {F7) @ Exit

Find Products LUsing

Product List

Quick Search: | = A\=zociated Product

| Chemical Associatet

Prog—Cpde lany portion]:

Manutactirer: [<All Manuractunes= =]
Supplier: —fi [IRM (0058) ~]
Dangerous Goods? |E'rther j
Inventory ltem? |Ei'ther ﬂ
Active? —_— |Yes J

4 Products found

e |f Use WO Pricing for PO (config) is checked, Unit Price will be copied.

e AR Release Numbers are not copied to the PO — but - you can copy AP release numbers from
a purchase order.

I want to read the AR Release Number white paper (with lots of screenshofs).
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What Will Be Copied from WO to PO?

The following fields will be copied from the Work Order when the Purchase Order is created:

Work Order
Reference Number
Date Ordered
Expiry Date

WO Sub Type
Header Location
Header Comments
Customer

Billing Address
Ship To

Service Dates

AR Sales Rep

Customer Contact

Supplier

Products

Work Order To Purchase Order Process

Purchase Order
Reference Number
Date Ordered

Expiry Date

PO Sub Type

Header Location
General tab Comments
Customer

Customer Billing Address
Customer Ship To
Expected Delivery

AR Sales Rep

Customer Contact

Supplier

Products

Notes

PO: company config option

WO: can be mandatory

must exist in both AR and AP

WO: can be mandatory
WO: can be mandatory
WO: can be mandatory
WO: can be mandatory

WO: Direct Order Suppliers only,
can be mandatory

Quantity, Units, Location;
Price: config option
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Creating the Purchase Orders

e Select Create Purchase Order from the Work Order home form to create the linked PO.

i
-] Work Orders

| + Add | A Edi | * Delete |ﬁ New Search | Copy | + Create Purchase OnidghlE* Preview rte{

il

1 2
J:,.qu@EL"Er Order Date — | Expiry Date Typem_ﬁ
e S i i et il

Accounts Receivable > Work Orders

Is the Create Purchase Order Button Greyed Out?

e If the button is inactive, ensure the PO Reference column is empty.

— s

History |(3 Bxit | already linked?

L3
% Copf | =+ Create Purchase Order | E Preview tem -
1 |

PO Reference
DP0O363

er Date = Expiry Date | Type Status
by 18, 2022 | Jun 30, 2023 | Order (Contract)

(? ‘wiork Order Number
0 | DW0363

Active

e Also ensure a Supplier was selected on the work order.

i 4
_ | Edit Work Order; SAWO&9 }
J = save | 7 Delete | /1. Documents ‘ Refresh ‘ Elwo Au:‘tivityz

>

3

Reference: [sawoss - 3

Customer: IBean, Heather (0002) 3
By

Date Ordered:  |Nov03.2022 ~|®  Swawus:  [Active J—;’

Expiry Date: Jun 20, 2022 - 2

Customer and Order | Products {1}' f
=

7

Billng Add -
L [Bilingfddess ) o upplier is needed
mw

i

Customer Contact: Il f LI _]F
Supplier: I LI 7?
:
b

Accounts Receivable > Work Orders

e After Create Purchase Order is selected, a new Purchase Order opens and a number of fields
default based on the Work Order. Details are copied to the header and to all 3 tabs.
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e Fields highlighted in yellow are linked to the work order and some cannot be edited (if they
are incorrect, Exit without saving the PO, correct the work order, then start the Create
Purchase Order Process again).

Purchase Order Header & General Tab

-

. Add Purchase Order E=R(E=RCXT)
J E save | 7 Delete .\L Documents | Refresh | E] PO Activity Detail | History |® Exit |
Reference: ) * [ Generste Reference Automatically Sub Type: ICormact LI
Supplier: I|R|"f'| (D058) j * Find | Add | Lecation: IDog River ;I *
Date Ordered: Nov 18,2022 ~|” Status: [Ordered =
Expected Delivery: |Dec 19,2022 v | to |Dec31.2022 [ =] [7 Mot Specfied Requested By (Stsff): |
Expiry Date: IJ'-'” 30.2023 j' I” No Expiry Date Confirmation Ne: |
roducts 3) I Customer and Order I
Supplier Location TR T T I Hedge Rate:
PR N PP

Comments: |Direct Shipmert

I Prepay Submitted?

Accounts Receivable > Work Orders

Purchase Order Products Tab

. Add Purchase Order =N =R~
J E save | 7 Delete .\L Documents | Refresh | E] PO Activity Detail | History | e Exit |
Reference: IDPO&GE’. * [ Generate Reference Automatically Sub Type: IContlact LI
Supplier: I|RM (DDSE) j * Find | Add | Lecation: IDog River ;I *
Date Ordered: Nov 18,2022 +|” Status: [Ordered -

Expected Delivery: |Dec 19,2022 7| fp |Dec 31,2022 [ [ et Caccifio
ErpyDale [1n 30,2023 ¥] T~ No Exiy Date what you pay the supplier,

not what the customer pays you

Generd  Products (3) | e Orderl (can be copied - config option)
Product/Description Qty Ordered | Received | Remaining Unit Price | Prepay | Status | Location Release Inventory
> | 4600 - 46-0-0 (MT) 420 00 [[] |Active |Dog River [
1152 - 11-52-0 (MT) 420 00 [[] |Active |Dog River &=
0060 - 0-0-60 (MT) 420 00 [[] |Active |Dog River &
Add Product Row | Add Non-Inventory Row | Total: | $0.00
Edit Row | Remove F{le Reopen A I Auto Order
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Purchase Order Customer and Order Tab

. Add Purchase Order EI@
[E Save | X Delete |}, Documents Refresh | E] PO Activity Detail Histary @ Exit
Reference: DPO363 * I Generate Reference Automatically Sub Type: |C0nt|act j
Supplier: ||Rf\"| (0058) J 1 Location: |Dog River j :
Date Ordered: Novig. 2022 =|” Status: [Order=d =]
Expected Delivery:  |Dec 19,2022 x| o [Dec31.2022  [~] [ Not Specfied Requested By (Staff): |
Expiry Date: Jun 30, 2023 2 ™ Mo Expiry Date T e |
Geneml] Products (3] Customer and Order ]
Customer: ICampbeII Park Fertilizer (1054) J Biling Address
34 Sturgeon Road
Werk Order: |DWO363 - Nov 18, 2022 =l St Albert, AE TN 4R7
Sales Rep: IChI'iE ﬂ
Customer Contact: IDE|E Evans ~| Fnd Phone #:
Ship To: |Campbel Park Road ~| Fnd
335 Campbell Park Road
St Albert, AB TEN 7L1
e Most of the customer information will be populated from the work order
e Sales Rep, Customer Contact, and Ship To can be changed
e if other details are incorrect: exit the purchase order without saving, correct the
information on the Work Order, and start the WO->PO Process again.
e Save the purchase order.
Purchase Order Home Form
The Purchase Order home displays the associated work order reference number.
The Work Order home form displays the associated purchase order reference number.
= = >
+iad FEn | KDsete | New Seach B3Coy [T Pmview ten  [DHeoy @6
Scoclir Do Redwmsce | Expiry Oate | Delivary Dws | Glaha | S Type Contrace Libed WO | &) | Locatien
;~ RN _Hv: 18 HG2 _DPS)EE oune. o kO ova | Dee 13 2002 _DIu-ad Conract _40-‘:11&'! Deg Fiver
1 Purchase Order found "."'-- o ’
..""c. ."‘v - = o3 I

+aad Fik | X Dere P New Sexch | B Cogy [T] Preview tem = CMﬁ‘o:i'"Q.‘;ﬂ

/£ 4 Work Occer ity 70 Felerance

Status .
0 | DOWO2E3 ‘Cf‘:llﬁf

Acave

Expry Date  Type
Jun 30, 2023 ' Onder (Contract)

Ovrder Date
Now 18, 2022

Customer
| > | Campbell Park Fertlizer

1 Work Crder foued

Work Order To Purchase Order Process
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Editing

e Both Work Order and Purchase Order can be edited (to the extent allowed by your chosen
configuration options).

e Subsequent changes to the Work Order will not be reflected on the linked Purchase Order,
nor vice versa.

e Unlinking happens only when the purchase order is deleted.

Business Rules for WO > PO Process

e Work Order to Purchase Order will always be on a 1:1 basis
e If config option Limit Products based on Supplier is checked:
e appliesto WO only
e quotes cannot be turned into an order (toggle button is greyed out)
e Process is initiated only from the Work Order (it’s a push from WO, there is no pull from PO)

e manually selecting a Customer and Work Order on a Purchase Order can still be done,
but none of the product information is copied

e After the Purchase Order has been created, the Work Order can still be edited but the
Purchase Order is not updated to match

e Copied Purchase Order fields that cannot be edited are: Supplier, Customer & Work Order
Reference; all other details can be edited

e |[f the created Purchase Order is deleted, the link to the Work Order is released;
the Work Order can then be used to create a NEW Purchase Order
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